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第 1章 序論 

 

 わが国の酪農をめぐる現状は，担い手の高齢化や後継者不足を背景に，乳用牛飼養

戸数が年率 4 %程度の減少傾向で推移する一方，飼養頭数は増加傾向にあり，1 戸当

たり経産牛飼養頭数は増加傾向で推移しており，大規模化が進展している（農林水産

省 2022c）。このため，酪農業務従事者の 1人当たり年間労働時間（2020年）は，2,057

時間であり，他の畜種（肉用牛 1,685時間，養豚 1,677時間）や，製造業 1,838時間に

比べ長い状況となっており，労働負担の軽減に向けた取り組みが必要とされている

（農林水産省 2022a）。 

 また，わが国の飼料自給率（全体）は，令和3年度（概算）のTDNベースで25 %，

このうち粗飼料が 76 %，濃厚飼料が 13 %と低く（農林水産省 2022a），飼料の多くを

海外に依存している。近年の輸入飼料価格の急激な高騰や飼料需給のひっ迫により，

経営は厳しさを増している。酪農の生産基盤の強化のためには，経営コストの 4–5割

程度を占める飼料費の低減が不可欠で，輸入飼料への過度な依存から転換し，国産飼

料に立脚した安定した畜産経営の確立が重要とされている（農林水産省 2022a）。 

 これらから，労働負担の軽減や自給飼料の利用拡大に向けた取り組みの施策のひと

つとして放牧の活用が推進されている。放牧は飼料の生産や給与，排せつ物の処理な

どの省力化が期待できるため，労働負担や生産コストの軽減に効果がある（農林水産

省 2022a）。乳牛の放牧頭数は，2020 年の時点で，全国で約 20 万頭と，総飼養頭数の

約 20 %とされる（農林水産省 2022b）。 

 放牧のほかに，労働負担の軽減に向けた取り組みとして，つなぎ飼いからフリース

トールへの飼養管理方式の改善が推進されている。乳牛の飼養実態に関するアンケー

ト（畜産技術協会 2015）によると，フリーストールもしくはフリーバーンによる放

し飼い方式を採用している農家は，搾乳牛では 24.6 %程度と必ずしも多くないものの，
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育成牛では 63.8 %，子牛では群飼もしくは繋がない方法での１頭飼いが合わせて 70 %

以上にのぼるとされる。 

 近年，スマート農業や農業のデジタルトランスフォーメーション（DX）と称され

る，労働力負担軽減・省力化に資するロボット，AI，IoT 等の先端技術の開発，活用

が推進されている（青木 2019；農林水産省 2002c）。その一つとしてドローンの活用が

ある。川村ら（2018）は，草地生態系におけるドローンの活用場面の例として，放牧

家畜の餌となる牧草資源量を知るための基礎的な情報である草地の収量評価，植被率，

牧草栄養価，雑草検出などを挙げている。ドローンを牛体へ利用した例として，ドロ

ーンを利用した牛の個体数の計測技術が報告されている（Barbedo 2020；Shao 2020）。

このほか，放牧管理のためのスマート農業技術として，電子タグを利用した放牧牛用

の自動体重測定手法（喜田ら 2021）や放牧牛の脱柵や疾病兆候を遠隔で検知する監

視システムが開発されており，放牧管理のさらなる省力化が期待されている。その一

つとして，牛の体重計測の省力化がある。牛の体重計測は一般管理作業の一環として

行われているが，後述するように労力や設備など，いくつかの問題が知られており，

省力的に体重計測ができる技術を開発する必要がある。 

 体重は，牛の生育状況や健康状態を把握し適正な飼養管理をするために重要な指標

であり，また，家畜の生産性や育種選抜を評価する指標として頻繁に使われる。たと

えば，乳牛の生産現場において体重情報は増体重の確認のみにとどまらず，種付け開

始時期の判断や，初回分娩時の体重として適切であるか，分娩後の体重回復が正常で

あるか，泌乳後期における過肥の予防が適切であるか，などの飼養管理の判断情報と

して利用される。さらに放牧飼養であれば，草資源の現存量と放牧圧の関係から，転

牧時期などの放牧計画の立案や実施の判断基準となる。このため，定期的，かつ継続

的に体重の測定を行うことが適切な飼養管理を行う上で重要である。 
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 しかしながら，牛の体重計は高価で大掛かりな設備であることから生産者ごとに備

えることができない。体重計測の設備を導入している公共牧場は，2000 年の時点で

57 %（動物衛生研究所 2002）とされ，牛群検定における体重情報の報告数は減少傾向

にある（相原 2017）。このように体重は有用な情報であるにもかかわらず体重測定が

広く行われていない理由は，高価で大掛かりな設備が必要であることのほかに，労力

がかかることや，牛が暴れることにより作業者に危険が及ぶなどが考えられる。 

 体重計測にかかる労力については，とりわけ牛を体重計まで誘導する際に多くの労

力を必要とする。牛はロープで引かれる際に嫌がることが多く，激しく抵抗し作業が

困難になる場合がある。このためロープ誘導に慣れておらず抵抗する牛を体重計まで

誘導する作業は重労働となり，牛の前方からロープを引く者と牛の後方から追う者の

複数の作業員が必要となることがしばしばある。放牧飼育では，自由に動き回ること

のできる牛をその場で捕獲してロープ誘導することは困難であるため集畜する必要が

あり，集畜ための技術とその労力を必要とする。しかしながら，搾乳作業，給餌作業，

清掃作業などの作業に追われている生産現場では，体重計測のための労力を確保する

ことが困難となっている実情がある。 

 牛はしばしば体重計測のために人に触れられることや体重計までの誘導の際に強く

嫌がり，抵抗反応を示し，さらに暴走反応を示すことがある。このように，体重計測

時の牛との接触は，管理者の負傷事故につながりやすい。北海道では牛との接触によ

る負傷事故の件数が乳牛，肉牛あわせて毎年 700件前後発生していると報告されてい

る（北海道農作業安全運動推進本部 2022）。北海道の酪農における牛との接触による

負傷のうち，移動・捕獲中の事故は28 %を占め，搾乳作業中の事故（43 %）についで

多い（高橋 2014）。志藤ら（2018）はアンケート調査により，都府県においても同様

に，事故事例として，蹴られる，踏まれる，のほかに，枠，柵，支柱などの畜舎構造

物と牛との間に挟まれる事故を挙げている。 
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 体重の測定手法は，現在のところ，家畜用台秤（体重計）のほか，牛体の一部から

体重を推定する手法がある。一般に牛の成長指標として計測される体型部位は，体重

を除くと，体高，体長，胸深，尻長，腰角幅，かん幅，管囲，胸囲，十字部高，胸幅，

坐骨幅の 11 部位あり，これらは体重とアロメトリー関係があると考えられる（Brody 

1945）。なかでも，胸囲は体重との相関が非常に高い部位であることが明らかになっ

ており，胸囲は牛の体重を推定するための手法として最も広く使用されている

（Davisら 1961；Heinrichs・Hargrove 1987；Heinrichsら 1992）。胸囲と体重との相関係数

は，ホルスタイン雄牛で 0.98（Branton・Salisbury 1946），18か月齢以下のホルスタイン

種で 0.99（Davis 1956）と，いずれも高いことが報告されている。ホルスタイン雌牛の

胸囲と体重との相関係数は生後 24か月齢までの 6か月間隔の調査で 0.73–0.85である

ことが報告されている（Davis 1954）。このほか，ジャージー種（Branton・Salisbury 

1946；Davis 1956），ショートホーン種（Braude・Walker 1949），ガンジー種（Davis 1956），

エアシャー種（Davis 1956）など多くの種で胸囲と体重との関係が報告されている。

現在，胸囲と体重との関係を利用した乳牛用体重推定尺が市販されており，生産現場

では簡易推定法のうち，体重推定尺が最も広く利用されている。このほか，かん幅も

同様に体重との相関が比較的高い部位として報告され（Heinrichsら 1992；Enevoldsen・

Lristensen 1997），かん幅を利用した体重推定器具としてヒポメーターが開発されてい

る。 

 体重計による体重測定は前述したとおり，設備や労力，危険性などの問題がある。

これに対して，推定尺やヒポメーターによる体重測定は，牛を移動することなくその

場で測定可能であるため，体重計を利用した場合にくらべて簡易的ではあるものの，

測定の際には牛を立たせて正姿勢を保つ必要がある。そもそも牛に直接触れる必要が

あるため，体重計での体重測定と同様に作業者が危険に曝される。なかでも推定尺は

テープを胸部に巻き付けるように当てる際に牛が暴れる危険性があり，かつ牛を正姿
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勢で保持する者と測定する者の最低 2名必要であることから労力の面においても課題

が残っている。また，牛が暴れることは，作業者にとってリスクになるだけでなく，

牛にとって大きなストレスを受けた結果であり，このような牛が持つ恐怖心はアニマ

ルウェルフェア（動物福祉）の点からも軽減されるべきである。 

 一方で，ビデオカメラやデジタルカメラの普及にともない，画像を用いた牛の体型

推定技術や体重推定技術の検討が行われてきた（緒方ら 2011；喜田ら 2014；Minagawa 

1994；喜田 2016；口田ら 1996，1997）。後に複数の 2Dカメラを並列に並べて撮影する

ステレオ方式の 3D 画像が牛体の解析に用いられるようになり（Tasdemir ら 2011；

Hansen ら 2018），最近ではデジタル画像解析技術の発展により，深度センサー等を利

用した 3D データによる体重および体型の推定に関する報告がされている（Kuzuhara

ら 2015；瀬戸ら 2018；Songら 2018；Martinsら 2020）。画像を利用する手法は，牛体に

触れることなく測定できることに加えて，これまで測定することが困難であった部位

の計測も可能である。例えば，牛の上部から鉛直方向で撮影された画像の牛体上部面

積（以下，面積）や外周長などを計測することもできる。これらの計測部位を体型指

標として利用することで，高い精度で体重を推定できる可能性がある。 

 しかしながら，今まで提案されてきた画像を用いた体重推定は，これまでの体重測

定法と同様に，立位姿勢（立位）で行うことが基本とされ，立位以外の姿勢から体重

を推定した報告は見られない。また，現在のところ牛舎内の通路や搾乳室などの牛の

移動がある程度制限できる場所で，撮影装置を固定した状態で利用することを前提と

している。そのため，移動が自由にできて，かつ自由な姿勢でいる放牧地で体重推定

することはできていない。撮影場所を特定せずに自由な場所で利用でき，自由な姿勢

で体重推定できる技術を開発することができれば，画像を用いた体重推定の利用範囲

が広がると考えられる。放牧やフリーストール，フリーバーンなどの自由飼育条件下

における牛の姿勢は，立位のみならず伏臥位姿勢（伏臥位：両前肢を折り曲げ両後肢
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を体に沿わせるように座った姿勢）や横臥位姿勢（横臥位：四肢を伸ばし完全に横倒

しの姿勢）（佐藤ら 1995）も見られる。ただし，伏臥位にくらべて横臥位の時間は非

常に短いとされる（鈴木ら 1978）。このことから，立位と伏臥位の両方の姿勢から体

重を推定することができれば，自由飼育条件下の牛の大部分の姿勢を計測対象とする

ことができると考えられる。 

 また，ホルスタイン種におけるこれまでの体型指標を用いた体重推定に関する研究

は未経産牛（Heinrichs・Hargrove 1987；Heinrichsら 1992；Dingwellら 2006；坂口ら 2006）

を対象にしたものが多く，わずかであるが泌乳牛（Yan ら 2009），肉牛（Ozkaya・

Bozkurt 2009）についての報告もある。しかし育成牛から経産牛までの広い体重域を対

象にした研究は少ない。経産牛においては，分娩およびその後の泌乳により骨格の大

きな変化を伴わない体重の増減があると考えられる。また，各部位の成長と体重の関

係が，成長段階で異なる可能性がある。しかし前述のとおり育成牛から経産牛までの

広い体重域を対象にした研究が少ないため明確ではない。育成牛から経産牛までを継

続して調査し，それぞれの時期について体型指標と体重の関係を解明することができ

れば，汎用的な牛の体重推定につながる。 

 以上のような背景に基づき，本論文では，画像を用いた乳牛の自由姿勢条件下での

体重計測技術を開発することを目的として，第 2章では体重計測のための撮影技術の

開発，第 3章では自由姿勢および生育ステージを考慮した牛の体重推定モデルの開発

を試みた。具体的には，第 2章については，簡易ジンバルを核とした，常に鉛直方向

を向き，牛の上部より安定的に牛体上部画像が撮影可能な撮影装置を開発し，それを

用いた場合の撮影距離が牛の体型測定値の推定に及ぼす影響について検討した。あわ

せて，機械学習を用いることで，撮影された画像から牛が写っている部分（以下，牛

領域）を自動的に抽出する手法について検討した。また，第 3章については，立位お

よび伏臥位の撮影画像から牛体部位を測定し，計測された体型指標と体重との関係を
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数理解析し，関係を表す体重推定モデルの探索を行った。さらに，第 4章では，総合

考察として，画像からの体重推定技術について，実際の生産現場での利用を想定して

技術的な要点を整理し，当該技術の精度向上および放牧地へ展開するために必要な事

項について考察を行った。 
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第 2章 放牧地における写真撮影を用いた牛体重計測のための撮影技術 

 

2.1 緒言 

 放牧地において撮影された画像から牛の体重を計測するにあたって，まず，画像の

撮影技術を確立することが必要である。画像やセンサーを用いた体重推定に関するこ

れまでの報告（口田ら 1996，1997；緒方ら 2011；喜田ら 2014；喜田 2016；Hansen ら 

2018）の多くは，舎内での利用を前提としており，放牧地に持ち出し可能なシステム

は，喜田ら（2014）の方法を除くとほとんどない。すなわち，牛の横方向から撮影し，

なおかつ牛とカメラとの撮影距離を一定にするために，主に牛の通路もしくは搾乳室

内で固定して撮影したものが多い。畜舎内や放牧地で，牛のいる場所へ持ち運びなが

ら撮影することが可能であれば，集畜やロープ誘導などの牛のハンドリングをしなく

て済むため省力化できる。ただし，放牧牛は自由に移動できるため，牛の横方向から

撮影した画像は，牛とカメラとの撮影距離を一定にすることが困難である。さらに，

画像からサイズを推定するために必要な長さの基準となるものを牛体と同時に撮影す

ることも困難であることから，放牧地において横方向で撮影された画像は体重推定に

利用しづらいと考えられる。その一方で，縦方向で得られた画像はこれらの問題を解

決できる可能性がある。しかしながら，牛体の真上からの画像を撮影する際，長尺棒

にカメラを直接取り付けただけでは，長尺棒を持つ角度の変化を補正できずに，斜め

から撮影された歪んだ画像となってしまい，体重推定には不適と考えられ，持つ角度

が変化しても常に牛体上部画像が容易に得られる撮影装置が必要である。 

 また，現在報告されている画像からの体重推定に関する研究はすべて立位姿勢で行

われている。しかし，放牧やフリーストールなどの自由飼育条件下では，立位のみな

らず伏臥位姿勢（伏臥位：両前肢を折り曲げ両後肢を体に沿わせるように座った姿勢）

や横臥位姿勢（横臥位：四肢を伸ばし完全に横倒しの姿勢）（佐藤ら 1995）も見られ
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る。ただし，伏臥位にくらべて横臥位の時間は非常に短いとされる（鈴木ら 1978）。

このことから，立位と伏臥位の姿勢の画像から体重を推定することができれば，自由

飼育条件下の牛の大部分の姿勢を計測対象とすることができると考えられる。後述す

る第 3章では，立位および伏臥位姿勢の画像から体重推定する技術を開発した。立位

や伏臥位といった姿勢に捕らわれず，かつ牛を保定することなく自由な姿勢で撮影で

きる技術を開発することができれば，第 3章で開発された技術と組み合わせることで

自由姿勢条件下での体重計測が可能となると考えられる。 

 そこで，本章は，放牧地への持ち出しが可能で牛の上部より鉛直方向に対して安定

的に牛体上部画像が撮影可能なカメラ保定方法を開発することを目的とする。撮影装

置を作製し，それを用いた場合の撮影距離が牛の体型測定値の推定に及ぼす影響につ

いて検討した。あわせて，撮影された画像から牛領域を省力的に抽出するために，機

械学習を用いて撮影画像の牛領域を自動的に抽出する手法についても検討した。 

 

2.2 材料と方法 

2.2.1 撮影装置の開発 

 長尺棒を持つ角度が変化しても常に牛の上部から鉛直方向に対して安定的に牛体上

部画像を撮影できる撮影装置として，長尺棒とデジタルカメラの間に，簡易的な 2軸

ジンバル（以下，ジンバル）を組み合わせた装置（図 2.1）の開発を試みた。ジンバ

ルは重力で傾きを修正する構造で，電気的制御を必要としない簡易的なものとした。

材料は家電量販店やホームセンターで入手可能なものを利用した。 
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2.2.2 作製した撮影装置による牛の自由姿勢条件下での撮影 

 新潟大学農学部附属フィールド科学教育研究センター（北緯 37度 41分，東経 139

度 11 分）の放牧地およびタイストール牛舎で飼養されているホルスタイン種雌牛を

対象として，作製したジンバルを組み合わせた撮影装置を使い，放牧地および牛舎内

の牛の立位および伏臥位の体上面画像を撮影し，1 画像の中に牛体全体が写るか確認

した。あわせてジンバルを利用せず，長尺棒に直接デジタルカメラを固定して撮影し

た画像と比較することで，撮影装置の有用性を検討した。 

2.2.3 牛の成長に伴う撮影距離の変化による 1画素あたりのサイズの関係 

 カメラから遠いものほど小さく写り，近いものほど大きく写るように，牛体とカメ

ラとの撮影距離が変化すると 1画素あたりのサイズが変化する。さらに，たとえカメ

ラを一定の高さに保持したとしても，牛の成長に伴って体高が変化し，撮影距離が変

化するため，同様に 1画素あたりのサイズが変化する。その変化の度合いを確認する

ために，撮影距離と 1画素あたりのサイズの関係を明らかにする必要がある。そこで，

カメラを高さ 4.00 mに設置し，牛の等身大パネルを高さ 0.47–1.66 mの範囲で 0.30 m毎

図 2.1 撮影装置の概略． 
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に変化させて撮影した（この場合の牛体とカメラ間の撮影距離は 3.53–2.33 m）。オー

プンソースの画像解析ソフト ImageJ / Fiji（Schindelinら 2012）を利用して牛の等身大パ

ネルにある腰角幅（0.86 m）の画素数を求め，撮影距離と 1 画素あたりのサイズの関

係（式 2.1）を算出した。 

 次に，地上高 4.44 m（60か月齢の牛の標準体高 1.44 m + 撮影距離 3.00 m）にカメラ

を保持して撮影したと仮定して（図 2.2），式 2.1 の関係を利用して成長にともなう腰

角幅を推定した。成長にともなう撮影距離の変化が，牛体計測値に与える影響につい

て，標準発育曲線（日本ホルスタイン登録協会 1995）の腰角幅の値を利用して検討

した。 

2.2.4 撮影した画像からの対象動物領域の抽出 

 牛床，台秤，放牧地の異なる条件下で撮影した牛の画像を用いて機械学習を利用し

た牛領域の抽出を行い，機械学習アルゴリズムによる牛領域抽出が可能かどうか確認

し，その有効性について検討した。機械学習は，機械学習統合機能である Weka 

(Waikato Environment for Knowledge Analysis) 上で作動する，ImageJ / Fiji のプラグイン

Trainable Weka Segmentation, ver. 3.2.33（以下 TWS）（Arganda-Carreras ら 2017），および

Graph Cut（Boykov・Kolmogorov 2004）を利用した（詳細は補遺 1参照）。識別のアルゴ

図 2.2 成長にともなう撮影距離の変化． 
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リズムとして Fast Random Forest 法を利用した。操作は矢部ら（2016）および秋山ら

（2018）を参考に，以下のように行った。①牛領域を class 1，背景領域を class 2 に指

定し，[Train classifier] により識別器による学習をさせた。② [Get probability] により各

class に属する確率を示した画像である Probability maps を得た。Graph Cut を使い，

Probability maps から牛領域と背景領域に分節した 2 値画像を取得した。③分節された

牛領域を関心領域（Region of Interest：ROI）として指定し，ROIマネージャーにより元

の画像に当てはめ，視覚的に輪郭に沿って牛領域の抽出ができているかを検討した。

視覚的に当てはまりが良いと判断された場合のみ，学習モデルとして保存し，他の検

証用画像への適用を試みた。 

 

2.3 結果 

2.3.1 撮影装置の開発 

 長尺棒とデジタルカメラの間にジンバルを組み合わせた撮影装置が開発された。ジ

ンバルには，中心軸の固定用にプラスチック製丸型容器の蓋（外径 7.5 cm）を，外周

に外径 9.0 cmの塩化ビニールパイプを細く輪切りにしたものを，利用した。それぞれ

4 ヵ所に穴を開け，軸が中心で直交するようにボルトで固定した。中心軸およびバラ

ンス軸には，寸切ボルト（ねじ径 M6）を使用し，中心軸下部にデジタルカメラを取

り付け，カメラの逆方向におもりを取り付けてバランスを調整した（図 2.3）。また，

カメラを水平に取り付けるためカメラのモニターに水平器（直径2 cm）を取り付けた。 

 なお，長尺棒はグラスファイバー製の検測桿（SK逆目盛8 m，名宣真工業，大阪市）

を利用し，先端から 0.5 m の位置に作製したジンバルとデジタルカメラ（IXY120，キ

ヤノン株式会社，東京）を取り付けた。総重量は1.9 kgだった。長尺棒は長さ1.4－8.0 

mまで伸長することができる。ただし，無理なく保持することが可能で，かつ牛体全

体が映るための条件として，長尺棒の基部の高さを 0.5 m とした時，長尺棒の長さを
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3.5－5.0 m，長尺棒の鉛直方向に対する角度を長尺棒の長さ 3.5 mでは 15－45°，長尺

棒の長さ 5.0 mでは 15－30°で撮影する必要があった（図 2.4）。 

 本装置では，カメラの動画撮影機能を利用した。撮影時に長尺棒を移動して牛の動

図 2.3 簡易 2軸ジンバルを利用した撮影装置． 

図 2.4 無理なく牛体全体を撮影するための撮影方法． 
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画を撮影した後，動画画像から牛体全体が写っている静止画を取得した。オープンソ

ースの動画再生ソフトウェア（VLCメディアプレーヤ，VideoLAN Project，フランス）

を使い，動画から静止画像（1280 × 720ピクセル，RGBカラー）を取得し，jpeg形式

の画像として保存した（詳細は補遺 2参照）。 

2.3.2 作製した撮影装置による牛の自由姿勢条件下での撮影 

 放牧地内で撮影装置を持ち歩いて無理なく撮影するために，長尺棒の基部の高さを

0.5 m，長尺棒の基部からジンバル取り付け点までの長さを 4.8 mとし，長尺棒の鉛直

方向に対する角度が 24.1°になるように保持した（図 2.5）。長尺棒のたわみを考慮し

ないで計算すると，カメラから地表面までの垂直距離は 4.6 m，長尺棒基部から牛ま

での水平距離は2.0 mとなる。これにより，放牧地で育成牛（体重394–466 kg）を撮影

したとき，1 画像の中に牛体全体が写る画像を得ることができた。放牧地で撮影装置

図 2.5 撮影装置を用いた放牧地での撮影． 
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を持って牛に近づいたとき逃避行動を取られたが，時間の経過とともに牛が撮影装置

に慣れ，立位だけでなく伏臥位の画像を取得できた（図2.6）。牛床部の天井高が約3.7 

mの牛舎内で成牛（体重 516–830 kg）を撮影したとき，カメラの高さが 3.1 mになるよ

うに，基部からジンバル取り付け点までの長さを 3.5 m，長尺棒の鉛直方向に対する

角度を 35–45°の範囲で調整することによって，1 画像の中に牛体全体が写る画像を

取得できた（図 2.7）。一方，ジンバルを利用せずに長尺棒にデジタルカメラを直接固

定して撮影した場合は，長尺棒を一定の角度で保持することが難しく，撮影方向を常

に安定して鉛直方向に向けることは困難であった（図 2.8）。そのため斜め上部からの

角度のついた画像となり，最終的に適切な牛体上部画像を安定的に得ることはできな

かった。 

 

  

図 2.6 撮影装置を用いた放牧地での撮影の例（a–b：立位，c–d：伏臥位）． 
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図 2.7 撮影装置を用いた牛舎内での撮影の例（a：立位，b：伏臥位）． 
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図 2.8 ジンバルを利用せず長尺棒に直接カメラを取り付けて撮影

した例． 

a：放牧地内，b：牛舎内（立位），c：牛舎内（伏臥位）． 
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2.3.3 牛の成長に伴う撮影距離の変化による 1画素あたりのサイズの関係 

 1 画素あたりのサイズ y（m/px）と撮影距離 x（m）の関係は，式 2.1 の直線関係で

示された（図 2.9）。 

y = 0.0009x+0.00002 (R2=0.9998, P<0.01) (2.1) 

確認のため，体長でも同様の計測と解析を実施し，式 2.1と同じ関係が得られた。 

 地上高 4.44 m（60か月齢の牛の標準体高 1.44 m + 撮影距離 3.00 m）にカメラを保持

して撮影したと仮定して（図 2.2），式 2.1 を利用して成長にともなう腰角幅を推定し

た。この条件で成長に伴う腰角幅を推定した時，実際は 60 か月齢以下では撮影距離

が 3.00 m より増えて小さく写る。0，12，24 か月齢で推定された腰角幅は，それぞれ

標準発育曲線の腰角幅より 3.2，2.7，1.0 cm低く推定された（図 2.10）。 

 

 

 

図 2.9 撮影距離と 1画素あたりのサイズの関係． 
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2.3.4 撮影した画像からの対象動物領域の抽出 

 牛床で得られた立位および伏臥位，各 5画像を用いて，それぞれの画像で学習と領

域抽出を繰り返し，目視で牛領域を抽出できているか確認した。その結果，全ての画

像において，正確に牛領域を抽出した画像は得られず，学習モデルは作成できなかっ

た。学習量を増やして改めて試みたところ，伏臥位の 1画像のみで牛領域を抽出する

ことができ，学習モデルとすることができた。しかし，得られた学習モデルを検証用

の別画像に適用したところ牛領域を抽出できなかった。同様に，台秤で得られた立位

の 4画像を用いて，学習モデルの作成を試みたが，いずれも正確に牛領域を抽出でき

なかった。 

 放牧地で得られた立位 3画像および，伏臥位 2画像を用いて，それぞれの画像で学

習と領域抽出を繰り返し，目視で牛領域を抽出できているか確認した。その結果，す

べての画像でおおむね牛領域に沿って抽出することができ，学習モデルとするこがで

きた。図 2.11 に放牧地で得られた伏臥位画像から TWS により牛領域を抽出した例を

図 2.10 成長にともなう撮影距離の変化が腰角幅の測定に及ぼす影響． 

○：標準発育曲線（日本ホルスタイン登録協会，1995）の腰角幅，

■：地上高 4.44 m（60か月齢の牛の体高 1.44 m + 撮影距離 3.00 m）に

カメラを保持して撮影したと仮定し推定した腰角幅． 
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示した。 

さらに，放牧地の立位画像から得られた 3個の学習モデルを，それぞれ検証用の他

個体の伏臥位の 3 画像に適用したところ，1 個のモデルは全ての画像で牛領域の抽出

が可能で，他 2個のモデルはそれぞれ 3画像中 2画像で牛領域の抽出が可能だった。

また，放牧地の伏臥位画像から得られた 2個の学習モデルをそれぞれ検証用の他個体

で立位の 3画像に適用したところ，両モデルともすべての画像で牛領域が抽出可能で

あった。伏臥位の画像から得た学習モデルを立位の抽出に利用した例を図 2.12に示し

た。 

 

 



 

 

 

2
1
 

 

図 2.11 Trainable Weka Segmentation による放牧地で撮影された画像からの牛領域の抽出． 

a：選択ツール freehand lines により牛領域を class 1，背景領域を class 2 として選び目標部分をラベリングした

後，[Train classifier] により識別器の学習をさせる，b：学習により分節化された画像，c：各ピクセルが各 class

に属する確率を画像で示した Probability maps，d：Probability maps からプラグイン Graph cut により class 1 領域

を選択して得られた 2 値画像． 
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2.4 考察 

2.4.1 撮影装置の特徴と牛の自由姿勢条件下での撮影 

 本章で作成された撮影装置は，長尺棒とデジタルカメラとの間にジンバルを組み合

わせた簡易的な構成であるが，ジンバルを使用することにより，長尺棒の傾きが変化

しても，体上面に対して常に鉛直方向の画像をカメラで撮影することができる。さら

に，軽量で持ち運びが容易である。よって放牧地において体上部画像を安定的に取得

するために十分なものであると考えられた。ポールカメラの作成についてはいくつか

図 2.12 Trainable Weka Segmentationによる放牧地で撮影された画像からの牛領域の

抽出および他画像への適用． 

Graph cutにより得られた牛領域（図 2.11d）をwand toolで選択した後，ツ

ールROI managerにより元の画像に当てはめた（黄線部分）．a：伏臥位に

対する適正な領域抽出，b：aの伏臥位の画像を学習モデルとし，立位の

画像に適用して牛領域を抽出したもの． 
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の事例が報告されており，植生調査用としてポールとカメラの間に電気式のジンバル

を取り付けた装置（森本ら 2017）や地形測定用としてポールに雲台を利用して直接

カメラを取り付けた装置（中田ら 2009；後藤 2015）が考案されている。しかしこれ

らの装置は撮影方向の調整が必要であるものや鉛直方向の撮影ができないものが多い。

本研究で考案された撮影装置はジンバルの操作や長尺棒の傾きを調整することなく容

易に鉛直方向の画像を撮影できる点に特徴がある。また，本装置は，家電量販店やホ

ームセンターで入手可能な材料で作成することができ，汎用性が高い。 

 本装置を利用することで，放牧地において立位および伏臥位の体上部画像を安定的

に撮影することが可能となった（図 2.6）。しかし，放牧地で撮影装置を持って牛に近

づいたとき，牛は逃避行動を取るため撮影に時間を要した。本研究では，時間の経過

とともに牛が撮影装置に慣れ，立位だけでなく伏臥位の画像を取得できたが，一般的

に牛の逃避行動の程度はさまざまである。牛の逃避行動は，家畜への接近方向や接近

速度により，反応が変化することが報告されており（Kosako ら 2008），牛へのアプロ

ーチ方法を工夫することで，より容易に撮影が可能となる可能性がある。その一方で，

牛の逃避行動を考慮して，なるべく牛から離れた位置から撮影できることが望まれる。

そのためには，より長い長尺棒を用いて，より水平に近い角度で保持することで牛か

ら離れた位置からの撮影が可能である。しかしながら，一般的に長尺棒が長いほど，

そして持つ角度が水平に近いほど支えるには大きな力を必要とする。さらに，カメラ

を保持する高さが低すぎると，牛との撮影距離が短くなり牛全体が 1画像に収まらな

くなる。そのため，本研究で開発された撮影装置を用いて，図2.6–2.7で示したような

体上部画像を安定的に取得するためには，2.3.1で示した撮影条件に適合させて長尺棒

を保持する必要があるが，今後，装置をさらに軽量なものに改良することで，2.3.1に

示した条件よりも広い範囲の条件で利用できる可能性がある。 

 ポールカメラを利用したこれまでの報告では，手元にモニター，スイッチなどの操
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作端末を有するものが多く，撮影に際してモニターを見ながら画像の構図を確認して

から撮影することが一般的な撮影手順と考えられる。しかし，本研究では動画撮影機

能を利用して動画撮影を行い，後に，動画画像から牛体全体が明瞭に写っている静止

画を取得する手法を用いた。その理由として，一つは手元の操作端末を必要としない

簡易的な装置にするためと，もう一つは大きい牛の場合，カメラと牛との距離によっ

て 1画像の中に牛全体が入り切らないことがあり，そのリスクを減らすためである。

動画撮影機能を利用した撮影手法では，カメラがおおよそ牛の中央部になるように長

尺棒を操作することで，操作端末で画像を確認しなくても 1画像の中に牛全体が入っ

た画像を問題なく取得することができた。さらに，長尺棒を持つ手元に新たに操作端

末を準備する必要がなく，簡易的な構成とすることができた。これにより，操作端末

を有する撮影装置での撮影に長尺棒の保持者と撮影者の 2名を必要とされたこれまで

の報告（森本ら 2017）に対して，本手法では 1名のみで長尺棒の保持と撮影をするこ

とが可能で，省力的に撮影することが可能となった。 

 なお，本撮影法は牛舎内のペンのような自由行動下でも適用可能であるが，その際

にはカメラの高さは牛舎の構造（天井の高さなど）で制限されるため，基部からジン

バル取り付け点までの長さと保持する角度の調整が必要である。 

2.4.2 撮影距離と牛体部位のサイズ補正の問題 

 撮影距離と 1画素あたりのサイズの関係は直線関係で示された（式 2.1）。この関係

を利用して，取得した体上面の画像から牛体部位を測定するためには，撮影距離を固

定する方法，もしくは撮影距離を計測する方法が考えられる。しかしながら，撮影距

離を固定するために長さと角度を常に一定に保持することは現実的に難しい。撮影毎

に撮影距離を測定することが可能であれば，撮影距離と 1画素あたりのサイズの関係

式から牛体部位を計算することができるが，画像と撮影距離が同時に記録される汎用

カメラは市販されていない。そのため，現時点で，式 2.1 の関係を利用して簡易に牛
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体部位の測定を行うことは難しいと考えており，測定方法についてはさらに検討する

必要がある。 

 このようなことから，第 3章で行なった画像からの体重推定には，撮影距離の補正

を行わず，撮影画像に牛と共に映っている，牛の足元付近にある構造物をサイズの基

準として利用する手法を採用した。足元付近をサイズの基準にした場合，カメラと牛

体部位の撮影距離が異なると，牛体部位の測定値は実際の値と異なる。これは，牛の

成長に伴って体高が高くなると，牛体上部とカメラ間の撮影距離が変動し，1 画素あ

たりのサイズが変わることによる。このため，画像から計測される各部位長や牛領域

の面積は，実際のサイズに牛の成長に伴う撮影距離の変化による誤差が混入するとい

う問題がある。この問題に対し，仮に，撮影距離の変化による影響を含む成長部位間

の値と体重との間にアロメトリー関係が示されれば，この関係を利用し撮影距離の変

化による影響が含まれる体型測定値から体重推定することにより，対応できる可能性

がある。 

 立位における乳牛の体高は，標準発育値（日本ホルスタイン登録協会 1995）によ

ると0，12，24，60か月齢でそれぞれ75.1，122.4，137.7，144.0 cmとされ，出生から変

化の大きい 24か月の間に 62.6 cm程度変化する。その一方で伏臥位の牛の体上部の高

さについての詳細な標準発育値は明らかにされていないものの，成長に伴う伏臥位の

牛の体上部の高さの変化量は，立位よりも小さいと考えられる。そのため，立位と伏

臥位で推定精度に違いが生じる可能性がある。 

 上記のことから，第 3章では，牛の足元付近にある構造物をサイズの基準として利

用して画像から測定された体型指標を利用して，そこで得られた体型指標と体重との

関係を解析し，体重を推定できる数理モデルを作成できるか，解析を行うこととした。 

2.4.3 撮影した画像からの対象動物領域の抽出 

 機械学習 TWS を利用した撮影画像からの牛領域の識別は，撮影場所によって識別
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結果に違いが生じた。すなわち，放牧地で撮影した画像ではおおむね牛領域に沿って

抽出することができた（図 2.11）のに対して，牛床と台秤で撮影した画像では，抽出

が困難であった。これは，ホルスタインの体色と牛床および台秤の白黒部分の識別が

困難であるためと考えられる。一方，牛体とその背景となる植物群落は色や構造が大

きく異なると考えられ，放牧地では牛床や台秤より牛領域を抽出しやすかったと考え

られる。 

 放牧地の立位と伏臥位それぞれの画像において作成された学習モデルは，同一姿勢

の他個体の牛領域の抽出に利用可能で，異なる姿勢の他個体の牛領域の抽出において

も適正な学習モデルを得ることができれば利用可能であると考えられる。 

 

2.5 まとめ 

本章では，放牧地および牛舎での飼養条件下で実施できる牛の撮影技術を提案し

た。簡易ジンバルと長尺棒を利用することで，牛の上部からカメラを常に鉛直方向に

向けた撮影が可能となった。この撮影装置は放牧地へ持ち運び可能で，立位および伏

臥位の姿勢の体上面画像を取得することができ，画像からの体重推定技術に応用でき

ると考えられる。また，この撮影装置は安価で容易に作成できる。 

 放牧地における画像からの牛領域の抽出には，機械学習の一つである TWS が有効

であることが示された。この手法は，一個体から作成された学習モデルを使い，多数

の個体および異なる姿勢の牛領域の抽出に利用できる。TWS は，オープンソースで

容易な操作で処理できるため，導入しやすいと考えられる。 
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第 3章 立位および伏臥位の画像を利用した体型指標による体重推定 

 

3.1 緒言 

 これまで，より簡易に体重を把握するため，胸囲や体高等の体型指標から簡便に体

重を推定する技術が研究されてきた（Davisら 1961；Heinrichs・Hargrove 1987；Heinrichs

ら 1992；寺田ら 1992；Dingwellら 2006；Heinrichsら 2017）。例えば，寺田ら（1992）は

重回帰分析により，ホルスタイン種における体重との関係が高い部位は，未経産牛で

は胸囲，経産牛では腰角幅，尻長および胸囲であることを報告し，Rahim（1996）は

黒毛和種去勢肥育牛の簡易体重推定のための体型指標として胸囲，体長，十字部高お

よびかん幅からなる推定式を示した。現在，胸囲から体重を推定する推定尺や，かん

幅から体重を推定するヒポメーターが商品化されている。 

 さらに，近年，牛体を撮影した画像を用いて体重を推定する手法が報告されている

（緒方ら 2011；Tasdemirら 2011；喜田ら 2014；Kuzuharaら 2015；喜田 2016；Hansenら 

2018；Martins ら 2020）。画像を利用する手法は，牛体に触れることなく測定できるこ

とに加えて，これまで測定することが困難であった部位の計測も可能である。例えば，

牛の上部から鉛直方向で撮影された画像の牛体上部面積（以下，面積）や外周長など

の体型指標を利用することが可能である。これらの指標を利用することで，高い精度

で体重を推定できる可能性がある。 

 しかしながら，画像を用いた体重推定は，立位姿勢（立位）の正姿勢で行うことが

基本とされ，現在のところ牛舎内の通路や搾乳室などの制限された場所での利用を前

提としており，立位以外の姿勢から体重を推定した報告は見られない。放牧やフリー

ストール，フリーバーンなどの自由飼育条件下では，立位のみならず伏臥位姿勢（伏

臥位：両前肢を折り曲げ両後肢を体に沿わせるように座った姿勢）や横臥位姿勢（横

臥位：四肢を伸ばし完全に横倒しの姿勢）（佐藤ら 1995）も見られる。ただし，伏臥
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位にくらべて横臥位の時間は非常に短いとされる（鈴木ら 1978）。このことから，立

位のみならず，伏臥位の体上部画像から得られた体型指標と体重との関係について明

らかにすることができれば，場所や姿勢にとらわれず測定でき，画像を用いた体重推

定の適用範囲が広がると考えられる。 

 また，ホルスタイン種におけるこれまでの体型指標を用いた体重推定に関する研究

は未経産牛（Heinrichs・Hargrove 1987；Heinrichsら 1992；Dingwellら 2006；坂口ら 2006）

を対象にしたものが多く，わずかであるが泌乳牛（Yan ら 2009），肉牛（Ozkaya・

Bozkurt 2009）についての報告もある。しかし育成牛から経産牛までの広い体重域を対

象にした研究は少ない。経産牛においては，分娩およびその後の泌乳により骨格の大

きな変化を伴わない体重の増減があると考えられる。また，各部位の成長と体重の関

係が，成長段階で異なる可能性がある。育成牛から経産牛までを継続して調査し，そ

れぞれの時期について体型指標と体重の関係を解明することができれば，汎用的な牛

の体重推定につながる。 

 そこで，本章は，ホルスタイン種雌牛の育成牛および経産牛を対象に，（1）立位お

よび伏臥位の画像から計測された体型指標と体重との関係を把握すること，および

（2）立位と伏臥位の体型指標から体重を推定するモデルを作成し，成長段階と姿勢

の違いが推定精度に及ぼす影響について明らかにすること，を目的とした。画像は第

2 章で開発された撮影装置を用いて取得した。撮影画像から腰角幅，体長，背骨長，

面積，外周長の 5つの体型指標を計測し実測体重との関係を解析した。 

 

3.2 材料と方法 

3.2.1 供試家畜 

 新潟大学農学部附属フィールド科学教育研究センターで飼養されているホルスタイ

ン種雌牛を対象とした。供試牛の合計頭数は 44頭（月齢 0–99ヵ月，体重約 45–890 kg）
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で，そのうち39頭を立位の画像に，36頭を伏臥位の画像に供試した（表3.1）。なお，

立位と伏臥位では，一部，同一個体による調査が行われた。 

 供試牛の飼養管理方法は，出生から約 7ヵ月齢（250 kg前後）まで牛舎内で飼養し，

以降はフリーストール牛舎と隣接する放牧地（0.33 ha）で飼養した。初産分娩の約 2

ヵ月前からは，タイストール牛舎で飼養した。出生から 50 日間は哺乳を行い，離乳

後はNRC乳牛飼養標準2001年・第7版（道立畜試・根釧農試NRC乳牛飼養標準2001

年版翻訳プロジェクトチーム 2002）の要求量を満たすように設計した飼料を給与し

た。 

 

 



 

 

 

3
0
 

  

姿勢 データセットの内容 画像数 頭数 1頭当たり画像数 月齢 体重 (kg)

立位 全体 457 39 2 – 21 (11.7 ± 5.9) 0 – 99 (32.4) 44.5 – 892.0 (516.9)

経産牛 239 22 1 – 21 (10.9 ± 6.6) 22 – 99 (52.0) 500.0 – 892.0 (682.3)

未経産牛 218 25 2 – 15 (8.7 ± 4.1) 0 – 26 (11.0) 44.5 – 732.0 (335.6)

未経産牛250 kg以上 138 23 1 – 13 (6.0 ± 4.3) 7 – 26 (15.2) 254.0 – 732.0 (450.4)

未経産牛250 kg未満 80 22 1 – 7 (3.6 ± 1.8) 0 – 9 (3.8) 44.5 – 243.0 (137.6)

伏臥位 全体 157 36 1 – 9 (4.4 ± 2.8) 0 – 99 (35.9) 47.5 – 892.0 (575.8)

経産牛 96 17 1 – 9 (5.6 ± 2.3) 22 – 99 (50.0) 514.0 – 892.0 (680.7)

未経産牛 61 24 1 – 8 (2.5 ± 1.6) 0 – 24 (13.9) 47.5 – 732.0 (410.9)

未経産牛250 kg以上 45 18 1 – 8 (2.5 ± 1.8) 8 – 24 (17.1) 256.0 – 732.0 (503.4)

未経産牛250 kg未満 16 13 1 – 2 (1.2 ± 0.4) 0 – 7 (4.6) 47.5 – 219.0 (150.7)

1頭当たり画像数，月齢および体重は，最小値—最大値 (平均値) を示す．

表3.1　データセットの概要．
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3.2.2 調査 

調査は 2018 年 2 月から 2020 年 9 月にかけて行った。デジタル台秤（TRU-TEST 

EC2000，富士平工業株式会社，東京）を用いて体重測定を行い，計測体重とした。

体重測定の当日または近接日にデジタルカメラ（IXY120，キヤノン株式会社，東京）

を利用して撮影し画像を取得した。立位は，台秤の上部にカメラを固定して撮影し，

伏臥位は，牛床または放牧地内で簡易ジンバルを組み合わせた手法（田中・板野 

2021）により牛の上部から撮影した。 

 調査の間隔は少なくとも 21日以上あけて行い，立位画像は，供試した 39頭から 1

頭あたり2–21画像（平均±標準偏差，11.7±5.9），延べ457画像を取得した（表3.1）。

伏臥位の画像は供試した 36頭から 1頭あたり 1–9画像（平均±標準偏差，4.4±2.8），

延べ 157画像を取得した。 

3.2.3 解析 

3.2.3.(1) 取得した画像からの体型指標の測定 

画像から測定した体型指標は，腰角幅，体長，背骨長，面積，外周長の 5項目とし

た（図 3.1）。腰角幅は左右の腰角間の直線距離（m），体長は肩端から尾の付け根ま

での水平距離（m），背骨長は体長の基準となる両端について背骨の湾曲に沿った距

離（m），面積は頭部，頸，尾尻，肢のうち足根部から先端部分を除いた部分の面積

（m2），外周長は面積測定と同様部分を囲む距離（m）である。長さ（m）は小数第

三位まで求めた。測定には，画像解析ソフト ImageJ / Fiji（Schindelinら 2012）を用いて

次の手法により行った（詳細は補遺 3 参照）。まず，長さ補正の基準には牛の足元に

ある構造物（牛床マット，体重計測盤など）を利用し，放牧地において基準となる構

造物がない場合はあらかじめ竹尺などを牛の足元において撮影し，基準として利用し

た（図 3.2）。ImageJ / Fijiのスケール補正機能により画素単位からm単位に補正した。

次に，各体型指標を目視により任意で抽出し，その長さおよび面積を測定した。 



 

32 

 

 

 

 

 

 

  

図 3.1 解析に利用した牛体上部画像および体型指標（a：立位，b：伏臥位）． 

x1：腰角幅，x2：体長，x3：背骨長，x4：面積，x5：外周長を示す． 
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3.2.3.(2) 体型指標および計測体重との相関分析 

5 つの体型指標を説明変数として，各説明変数間および各説明変数と計測体重間の

関係を示すために，ピアソンの積率相関係数により相関分析を行った。解析は R 

version 3.6.1（R Core Team 2019）およびPackage ‘psych’（Revelle 2020）を用いた。 

3.2.3.(3) モデルの作成 

 牛の体型指標と計測体重との関係は，育成前中期と性成熟にいたる育成後期以降で

異なることが知られている。また一般にホルスタイン種雌牛の初回発情・種付けは体

重 350 kg以上が目安とされていることから，その境界は 350 kg以下と考えられる。本

手法によるモデルで計測体重と予測体重の関係を解析したところ，体重 250 kg前後を

境界にして両者の関係が異なると視覚的に判断された。そこで本報でのデータセット

については，立位，伏臥位共に，全体を対象にしたデータセット，未経産牛および経

産牛に分けたデータセット，未経産牛を計測体重 250 kg以上および 250 kg未満に分け

たデータセットによる解析を行った（表 3.1）。立位の全体のデータセットは 457画像

で，内訳は経産牛のデータセット 239画像および未経産牛のデータセット 218画像か

図 3.2 解析に利用した放牧地で撮影された伏臥位画像の例． 

矢印は長さの基準として設置した竹尺（1 m）を示す． 
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らなる。さらに未経産牛については 250 kg以上の未経産牛のデータセット 138画像お

よび 250 kg 未満の未経産牛のデータセット 80 画像からなる。伏臥位も同様に，全体

のデータセットは157画像で，内訳は経産牛のデータセット96画像および未経産牛の

データセット 61 画像からなる。さらに未経産牛については 250 kg 以上の未経産牛の

データセット 45画像および 250 kg未満の未経産牛のデータセット 16画像からなる。 

 それぞれのデータセットに，計測体重を目的変数，体型指標（腰角幅，体長，背骨

長，面積，外周長）の計測値およびそれらを全て組み合わせた交互作用を説明変数と

して，一般線形モデルに当てはめた。モデルの当てはめには R の lm関数を用い，最

適なモデル探索のために，有意差が無い説明変数をP値が高い順に削除しながら当て

はめを繰り返した（プログラムは補遺 4 参照）。さらに偏回帰係数がマイナスの変数

についてP値が高い順に削除しながら当てはめを繰り返すことで適切なモデルを探索

した。 

3.2.3.(4) モデルの評価 

モデルの評価には，計測体重とモデルによる予測体重間の相関係数（r）および平

均平方二乗誤差率（RMSPE）を用いた。RMSPEは，式3.1に示した。これは，予測体

重と計測体重との差（誤差）の大きさを示す指標で，値が小さいほど誤差の少ないモ

デルであることを示す。 

RMSPE = √1

𝑛
∑ (

𝑀𝑖−𝑃𝑖

𝑀𝑖
)
2

𝑛
𝑖=1  （3.1） 

ここで，nはデータ数，Miは i番目の計測体重，Piは i番目の予測体重を示す。rが高

く，かつ RMSPEが小さいモデルを精度の高いモデルと評価した。 

3.2.3.(5) 立位と伏臥位から作成されたモデルの一致性 

 全データのうち，同一個体から両姿勢の画像を同時に取得できたデータ 71 件を用

いて，牛の成長段階に応じて，250 kg 以上の未経産牛，250 kg 未満の未経産牛および
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経産牛の体重推定モデル使い，対応する立位と伏臥位の体重を推定し，相関分析によ

り一致性を検討した。 

 

3.3 結果 

3.3.1 体型指標と計測体重との相関分析 

 各体型指標間および各体型指標と計測体重との関係は，立位および伏臥位の両姿勢

においてすべて強い正の相関がみられた（図 3.3–3.4，すべてP < 0.01）。ただし，その

関係は完全な比例関係ではなく，湾曲（アロメトリー）関係を示すものが多かった。

各体型指標と計測体重の相関係数（r）は，伏臥位（r = 0.85–0.98）にくらべて，立位

（r = 0.95–0.99）でより高い値を示した。体重との相関係数が最も高い体型指標は，立

位および伏臥位のいずれにおいても面積で，それぞれr = 0.99およびr = 0.98であった。 

 立位における，体重と相関の高い体型指標は，面積（r = 0.99）＞外周長（r = 0.97）

＞腰角幅，体長（r = 0.96）＞背骨長（r = 0.95）の順であった。また，伏臥位における，

体重と相関の高い体型指標は，面積（r = 0.98）＞外周長（r = 0.95）＞体長（r = 0.92）

＞背骨長（r = 0.90）＞腰角幅（r = 0.85）の順であった。 
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図 3.3 各体型指標間および各体型指標と計測体重との相関関係（立位）． 

左上から右下の対角中央のグラフ：各データのヒストグラム，対角中央より

右上：相関係数 r，対角中央より左下：各データ間の相関グラフ．x1：腰角幅，

x2：体長，x3：背骨長，x4：面積，x5：外周長，y：体重を示す． 
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図 3.4 各体型指標間および各体型指標と計測体重との相関関係（伏臥位）． 

記号は図 3.3と同様． 
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3.3.2 体重推定モデル 

 体型指標から体重を推定する最適なモデルを表 3.2 に示した。計測体重とモデルに

よる予測体重間には，すべてのデータセットで非常に強い相関関係を示した（立位の

経産牛で r = 0.87，それ以外で r > 0.93，全てP < 0.01）。また全ての体重推定モデルにお

いて，面積が説明変数として選択された。 

 全体を対象としたデータセットのうち，立位は説明変数を面積のみとしたモデルが

最適モデルとなった。伏臥位は説明変数として面積のほかに，腰角幅と体長の交互作

用を加えたものが最適モデルとなった。 

 立位において経産牛と未経産牛とに分けたデータセットのうち，経産牛では面積の

み，未経産牛では面積および面積と体長の交互作用を説明変数としたモデルが最適モ

デルとなった。伏臥位おいては，経産牛では面積および腰角幅と体長の交互作用，未

経産牛では面積のみを説明変数としたモデルが最適モデルとなった。 

 未経産牛を 250 kg以上と，250 kg未満に分けた場合は，いずれの姿勢においても説

明変数として面積のみからなるモデルが最適なモデルとなった。 

 

表3.2　一般線形回帰による推定モデル．

姿勢 データセットの内容 データ数 推定モデル r RMSPE

立位 全体 457 y = -46.38 + 260.22 x4 0.99 0.09

経産牛 239 y = -37.57 + 258.39 x4 0.87 0.06

未経産牛 218 y = -17.15 + 198.89 x4 + 18.59 x4x2 0.99 0.07

未経産牛250 kg以上 138 y = -43.47 + 254.82 x4 0.97 0.07

未経産牛250 kg未満 80 y = -6.67 + 206.24 x4 0.99 0.06

伏臥位 全体 157 y = -167.92 + 482.75 x4 + 82.97 x1x2 0.98 0.17

経産牛 96 y = -178.14 + 499.91 x4 + 66.08 x1x2 0.93 0.05

未経産牛 61 y = -163.01 + 511.67 x4 0.98 0.25

未経産牛250 kg以上 45 y = -241.09 + 570.57 x4 0.98 0.06

未経産牛250 kg未満 16 y = -27.59 + 293.98 x4 0.99 0.07

推定モデルの記号は y：体重，x1：腰角幅，x2：体長，x4：面積を示す．

r：相関係数，RMSPE：平均平方二乗誤差率．

rはすべてのモデルでP < 0.01 (t -test)．
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3.3.3 モデルの評価 

3.3.3.(1) 全体を対象としたモデル 

 立位と伏臥位において，全てのデータを使い作成したモデルからの予測体重と計測

体重の関係を図 3.5に示した。予測体重と計測体重間の相関係数は立位で r = 0.99，伏

臥位で r = 0.98，RMSPEは立位で 0.09，伏臥位で 0.17を示し，両者とも 1：1ラインの

付近でばらついた。 

 ただし，立位および伏臥位ともに 150 kg以下の低い体重域における予測体重は計測

体重よりも過小評価される傾向があり，その傾向は伏臥位で強かった（図 3.5）。また，

450 kg以上の高い体重域では，予測体重はばらつきが大きくなった。 

 計測体重を経産牛，未経産牛，250 kg以上の未経産牛および 250 kg未満に分けた時，

全体モデルで予測された体重の精度を表 3.3に示した。経産牛では，立位において r = 

0.87，伏臥位において r = 0.93と他の生育ステージと比較して低い相関係数を示した。

また，予測体重が過小評価される傾向を示した 250 kg未満の未経産牛では，立位にお

いてRMSPE = 0.18，伏臥位においてRMSPE = 0.51と誤差率が高いことを示した。 

表3.3　体重推定モデルの各データセットに対する予測体重の精度．

立位 伏臥位

データ数 r RMSPE データ数 r RMSPE

全体のモデル 全体 457 0.99 0.09 157 0.98 0.17

経産牛 239 0.87 0.06 96 0.93 0.05

未経産牛 218 0.99 0.12 61 0.98 0.27

未経産牛250 kg以上 138 0.97 0.07 45 0.98 0.08

未経産牛250 kg未満 80 0.99 0.18 16 0.99 0.51

経産牛のモデル 経産牛 239 0.87 0.06 96 0.93 0.05

未経産牛のモデル 未経産牛 218 0.99 0.07 61 0.98 0.25

未経産牛250 kg以上 138 0.97 0.07 45 0.98 0.08

未経産牛250 kg未満 80 0.99 0.07 16 0.99 0.47

未経産牛250 kg以上のモデル 未経産牛250 kg以上 138 0.97 0.07 45 0.98 0.06

未経産牛250 kg未満のモデル 未経産牛250 kg未満 80 0.99 0.06 16 0.99 0.07

r：相関係数，RMSPE：平均平方二乗誤差率．

rはすべてのモデルでP < 0.01 (t -test)．

推定モデル 利用データセット
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図 3.5 全体を対象としたモデルによる予測体重と計測体重の関係． 

（a）：立位，（b）：伏臥位．n：供試点数，r ：相関係数，RMSPE：平均平方二乗誤差率．

*は P < 0.01（t-test）を示す．中央対角線は計測体重と予測体重の 1:1 ラインを示す． 
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3.3.3.(2) 経産牛と未経産牛を対象としたモデル 

 経産牛と未経産牛に分けたモデルの予測体重と計測体重との関係を図 3.6 に示した。

経産牛と未経産牛に分けたことで，全体のモデルで見られた 150 kg以下の低い体重域

における予測体重が計測体重よりも過小評価される傾向は，立位で改善された。しか

し，伏臥位では予測体重が過小評価となった。（図 3.6）。 

 モデルの推定精度は，立位において，経産牛でr = 0.87，未経産牛でr = 0.99を示し，

経産牛が未経産牛より低くなった（表 3.3）。伏臥位では，経産牛で r = 0.93，RMSPE = 

0.05，未経産牛で r = 0.98，RMSPE = 0.25を示し，経産牛は未経産牛と比較して，誤差

率は小さかった一方で相関係数は低かった。 

 表3.3に示したように，未経産牛の計測体重を250 kg以上と250 kg未満に分けた時，

未経産牛モデルで予測された体重の精度は，立位では，250 kg以上と 250 kg未満共に

高い相関係数と低い RMSPE となり，高い推定精度を示した。伏臥位では，相関係数

は250 kg以上，250 kg未満共に高い値を示したが，RMSPEは250 kg以上で0.08，250 kg

未満で 0.47となり，250 kg未満で高い誤差率を示した。 

3.3.3.(3) 250 kg以上の未経産牛と 250 kg未満の未経産牛を対象としたモデル 

図 3.6 の経産牛と未経産牛のモデルの予測体重と計測体重の関係のうち，未経産牛

のデータを 250 kg以上と 250 kg未満に分けて作成したモデルの予測体重と計測体重と

の関係を図 3.7 に示した。図には，比較のため，経産牛のモデルの予測体重と計測体

重の関係も示した。250 kg 以上の未経産牛の立位と伏臥位におけるモデルは，立位で

r ＝ 0.97，RMSPE = 0.07，伏臥位で r ＝ 0.98，RMSPE = 0.06となり高い推定精度を示し

た。250 kg 未満の未経産牛の立位と伏臥位におけるモデルは，立位で r ＝ 0.99，

RMSPE = 0.06，伏臥位で r ＝ 0.99，RMSPE = 0.07となり高い推定精度を示した（表 3.3）。 
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図 3.6 未経産牛と経産牛を対象としたモデルによる予測体重と計測体重の関係． 

（a）：立位，（b）：伏臥位．○：経産牛を対象としたモデルによる推定，□：未経産牛を対象とした

モデルによる推定．n：供試点数，r ：相関係数，RMSPE：平均平方二乗誤差率．*は P < 0.01（t-

test）を示す．中央対角線は計測体重と予測体重の 1:1 ラインを示す． 
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図 3.7 250 kg 以上の未経産牛，250 kg 未満の未経産牛および経産牛を対象としたモデルによる予測体重と計

測体重の関係． 

（a）：立位，（b）：伏臥位．○：経産牛を対象としたモデルによる推定，△： 250 kg 以上の未経産牛

を対象としたモデルによる推定，×：250 kg 未満の未経産牛を対象としたモデルによる推定．n：供

試点数，r ：相関係数，RMSPE：平均平方二乗誤差率．*は P < 0.01（t-test）を示す．中央対角線は

計測体重と予測体重の 1:1 ラインを示す．経産牛のデータは図 5 と同じ． 
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3.3.3.(4) 立位および伏臥位から推定された予測値の一致性 

 作成したモデルを利用し，対応する立位と伏臥位の画像データから推定した体重の

関係を図 3.8に示した。両姿勢の予測値は，1:1ライン上近辺にあり，姿勢の違いによ

る予測値の偏りは示されなかった。未経産牛の 250 kg未満では供試点数が 2件のみで

あるが，立位と伏臥位からの予測値は一致した。未経産牛の 250 kg以上において，推

定体重が 550 kgまでは立位と伏臥位の予測値は一致したが，推定体重が 550 kgを越え

ると一致性にばらつきが見られた。経産牛は未経産牛より一致性のばらつきが大きか

った。 

 立位と伏臥位の画像データからそれぞれ推定された予測体重間の関係は，全データ

で r = 0.94，250 kg以上の未経産牛で 0.95および経産牛で 0.83を示した。 

 

図 3.8 立位および伏臥位のモデルによる予測体重の関係． 

○：経産牛を対象としたモデルによる推定，△：250 kg 以

上の未経産牛を対象としたモデルによる推定，×：250 kg

未満の未経産牛を対象としたモデルによる推定．n：供試

点数，r ：相関係数．*はP < 0.01（t-test）を示す． 
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3.4 考察 

3.4.1 画像を利用した体型計測 

本研究で利用した体型指標の測定値は画像から計測しており，その際のスケール

補正はすべて牛の足元にある構造物等のサイズを基準として行った。画像から計測さ

れる牛体上部の位置は構造物の位置と高さが異なるため，直接測定する場合と異なる

計測値になる。加えて，構造物から牛体上部の位置が離れるに従い，その影響が大き

くなる。これにより体重と体型指標の間のアロメトリー関係に影響すると考えられる

が，本研究では体重と体型指標の間に明確なアロメトリー関係が示されており（図

3.3–3.4），画像から測定された体型指標は体重推定モデルの作成に十分利用できると

考えられる。 

 ただし，成長段階で分けた体重推定モデルの推定精度が，立位よりも伏臥位でわず

かに高かった（表 3.2および図 3.7）のは，立位は成長にともなって構造物からの距離

が大きく変化するのに対して，伏臥位は成長しても構造物からの距離が大きく変化し

ないことによる可能性がある。 

 なお，画像から各体型指標を測定するためのサイズ補正には，1 頭当たり 15–30 秒

程度を要する。体型指標のうち，腰角幅，体長，背骨長の選択にはそれぞれ数秒程度

で可能である。面積および外周長を測定するための牛領域の抽出は，難しい作業では

ないが，その所要時間は，両姿勢とも 1頭当たり 5分程度要するため，より短時間で

牛領域を抽出する技術を検討する必要がある。例えば，田中・板野（2021）は，機械

学習による牛領域の抽出技術の可能性について検討している。 

3.4.2 牛体上部画像の体型指標と体重の関係 

 一般に牛の成長指標として計測される体型部位は体重を除くと 11 部位あり，これ

らは体重とアロメトリー関係があると考えられる（Brody 1945；福原 1976）。ホルスタ

イン種において，秋元・勝森（1964）は体型部位間の成長にアロメトリー関係がある
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ことを示しており，これより体重と体型部位の間にも同様の関係があると考えられる。

今回計測した 5部位のうち腰角幅，体長，背骨長は，11部位のうちの腰角幅，体長に

対応していると考えられ，本研究においても体重との間に高いアロメトリー関係を示

した（図 3.3–3.4）。 

 本研究で使用した 5部位のうち体重と最も高い相関関係を示したのは，両姿勢とも

に面積，次に外周長であった（図 3.3–3.4）。面積や外周長を，11 部位のように現場で

計測することは困難である。しかしながら，画像解析技術を取り入れることで，計測

することが可能となった。 

 このことから，牛体上部画像から計測された面積は，体重推定の指標として，有用

と考えられる。緒方ら（2011）は，黒毛和種において体上部から撮影された画像を用

いて牛体の画素数と体重との関係が高いことを報告している。また，豚においても上

方投影面積と体重に高い相関があることが報告されている（皆川・村上 2001）。本研

究においても，全ての成長段階での体重推定モデルの説明変数として，面積が選択さ

れた（表 3.2）。 

3.4.3 生育ステージと体重推定モデル 

 本結果は，画像から乳牛の体重計測を行うときは，生育ステージに分けた推定モデ

ルを利用することが有効であることを示した。 

 全体モデルはすべての体重域で利用できるが，低い体重域にある 250 kg未満の未経

産牛では，計測体重に対して予測体重が過小評価される傾向が見られた（図 3.5）。各

生育ステージのモデルを使うことで，250 kg 未満の未経産牛における予測値の過小評

価の傾向は見られず（図 3.7），高い精度で推定できることが明らかとなった（表 3.3）。

生育ステージによって異なるモデルとなるのは，生育ステージによって成長に伴う体

重と体型部位の変動の関係が異なったことに起因すると考えられる。本研究において

体型部位と体重の関係は，完全な線形ではなく，アロメトリー関係を示した（図 3.3–
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3.4）。これは体型部位と体重の関係が生育ステージにより異なることを示唆している。

動物の各組織の発育はすべて同一歩調で行われるものではなく，それぞれ一定の順序

に従って発育することが知られている（Hammond 1960）。また，ホルスタイン種にお

いても重回帰分析により各体型測定値の体重への寄与度が未経産牛と経産牛で変化す

ることが示唆されている（寺田ら 1992）。本研究のモデルは線形モデルを採用してい

るため，全体モデルは，生育ステージ間の体型指標と体重の関係の違いを補正できな

かったと考えられる。変数を対数化し体型指標と体重とのアロメトリー関係を線形に

変換する等の手法を採用することで，適切な全体モデルを作成できる可能性がある。 

 一方，高い体重域にある経産牛では，全体モデル，経産牛のみのモデルのどちらを

利用しても，予測体重と計測体重の関係は大きくばらつき，生育ステージを考慮した

効果は示されなかった。経産牛では，分娩後の泌乳に伴うエネルギーバランスの変化

により，体重が大きく変動することが知られている。その変動に骨格サイズは強く関

与しないと考えられるため，画像から推定した体型指標のみを説明変数にしたのでは，

精度の高い推定ができないと考えられる。この問題に対処するため，体型指標に加え，

分娩後の日数，泌乳量などのエネルギーバランスの変動を説明する変数を加えた体重

推定モデルを検討していく必要がある。 

3.4.4 伏臥位の画像を利用した体重推定 

 本研究では，牛の伏臥位の画像を使い体重を推定できることが示された。体重推定

に関するこれまでの報告として，胸囲（Davisら 1961；Heinrichsら 1992；寺田ら 1992；

Ozkaya・Bozkurt 2009；Yanら 2009；Heinrichsら 2017），かん幅（Dingwellら 2006；坂口

ら 2006）から推定する方法および画像（緒方ら 2011；Tasdemirら 2011；喜田ら 2014；

Kuzuharaら 2015；喜田 2016；Hansenら 2018；Martinsら 2020）を利用する方法があるが，

いずれも立位姿勢で計測したものである。立位姿勢を使い決まった姿勢を維持するこ

とで，姿勢の歪みによる体型指標の測定誤差が少なくなり，体重の推定精度が高くな
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ると期待される。一方，伏臥位では，身体の歪みによって体型指標の測定誤差が生じ

ると考えられる。本結果においても体重と体型指標との相関関係は，立位の方が伏臥

位より高くなった（図 3.3–3.4）。しかしながら，複数の体型指標を説明変数としたモ

デルを利用することで，伏臥位からも立位と同程度の推定精度で体重を推定できた。

また，対応する立位と伏臥位から推定した予測体重の関係は 1：1 ライン上にばらつ

く（図 3.8）ことから，姿勢の違いにより体重を過小もしくは過大に推定することは

ないと考えられる。 

 画像を利用した体重推定の有用性として，家畜への接触や計測場所への誘導など，

管理者の家畜へのハンドリングが少なくすむ点が考えられる。これにより，牛の多様

な飼養環境，例えば，放牧中でも，画像を撮影することで体重を計測できる可能性が

ある。牛は休息時には，立位より伏臥位をとることが多い。石井（1986）は，放牧さ

れているホルスタイン種去勢牛の休息と反芻時間のうち 71 %が伏臥位および横臥位

がしめることを報告している。伏臥位画像を使い高い精度で体重を推定できることを

示した本研究の結果は，牛の体重計測の汎用性と応用性を考えたとき極めて有用と考

えられる。 

 牛が横になっている姿勢には，伏臥位以外に横臥位があるが，本研究で横臥位と体

重の関係を解析しなかった。これは，実際に横臥位がほとんど観察されなかったこと

による。横臥位と伏臥位では異なった体重推定モデルとなることも考えられるため，

今後，横臥位の体型指標に基づく体重推定モデルについても検討する必要がある。 

 

3.5 まとめ 

 本章は，体上部画像から体重を推定することが可能であることを示した。本章の手

法を用いることで，生育ステージに応じた推定モデルを適用することにより未経産牛

の体重推定は高い精度で行えることを示した。しかしながら，経産牛の体重の推定精
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度を改善するため，体型指標に加え泌乳期間中の体重の変動を考慮したモデルを検討

していく必要がある。また，生育ステージを通じた全体モデルを作成するためには，

体重および体型指標の対数変換等が有効かもしれない。 

 体重推定のために必要とされる体上部画像は，立位画像のみならず，伏臥位画像で

も利用できることを示した。これは放牧やフリーバーンで飼養されている牛の自由姿

勢条件での体重計測技術の開発につながると考えられる。放牧地での利用を考える場

合，ドローンによる空撮を用いた牛の画像取得技術が有効となるかもしれない。また，

伏臥位のみでなく横臥位における体重推定モデルの作成が必要であろう。 
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第 4章 総合考察 

 

4.1 画像と数理モデルを用いた体重計測技術の概要 

 体重は，牛の生育状況や健康状態を把握し適正な飼養管理をするために重要な指標

であり，また，家畜の生産性や育種選抜を評価する指標として頻繁に使われる。しか

し，牛の体重計は大掛かりで高価な設備であるため生産者ごとに備えることはできず，

体重計測の設備を導入している公共牧場は多くない。現在，簡易的に体重を推定する

ために胸囲から体重を推定する推定尺が市販されているが，それでも測定作業に労力

がかかることや測定時の危険性の問題などの理由から，牛の体重測定はあまり行われ

ていない。そのため，より省力的で簡易な体重推定技術を開発する必要がある。 

 そこで，本論文では新たな体重推定技術として，画像を用いた乳牛の自由姿勢条件

下での体重計測技術を開発することを目的として，体重計測のための撮影技術の開発

（第 2 章）と，自由姿勢および生育ステージを考慮した牛の体重推定モデルの開発

（第 3章）を試みた。 

 まず，第 2章において，長尺棒に簡易ジンバルを組み合わせた撮影装置を開発した。

この装置を利用することで，持つ角度が変化しても常に鉛直方向を向き，安定的に牛

体上部の画像を撮影することが可能となった。さらに，この撮影装置は軽量であるた

め牛舎内や放牧地に持ち運んで撮影することが可能で，立位および伏臥位の両姿勢の

画像を撮影することが可能となった。撮影された画像について，撮影距離が牛の体型

測定値の測定に及ぼす影響について検討し，スケール補正は牛の足元付近にある構造

物をサイズの基準として行うことを提案した。また，放牧地で撮影された画像から牛

領域を抽出する技術として，機械学習の一つである TWS の利用を検討した結果，作

成された学習モデルを利用して，多数の個体および異なる姿勢の牛領域を抽出できる

ことが示された。 
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 次に第 3章において，第 2章で開発された撮影技術を利用して，乳牛の立位および

伏臥位条件下で撮影した。その撮影画像から牛体部位を測定し，計測された体型指標

と体重との関係を数理解析し，関係を表す体重推定モデルの探索を行った。その結果，

体重と体型指標の間に明確なアロメトリー関係が示されており，画像から測定された

体型指標は体重推定モデルの作成に十分利用できることが明らかとなった。体重と最

も高い相関関係を示した体型指標は，両姿勢ともに面積，次に外周長であり，面積は

両姿勢のすべての成長段階での体重推定モデルの説明変数として選択された。未経産

牛の推定精度は，生育ステージに応じた体重推定モデルを適用することにより高い精

度で推定できることが示された。一方，経産牛の推定精度は未経産牛にくらべて低い

ことが示された。また，立位からの予測値と伏臥位からの予測値はおおむね一致して

おり，姿勢の違いにより体重を過小もしくは過大に推定することはないと考えられた。 

 これらにより，画像を用いた乳牛の自由姿勢条件下での体重計測技術が開発された。

この技術は，撮影装置を牛のいる場所へ持ち運んで撮影することができ，放牧されて

いる乳牛の姿勢として多く見られる立位および伏臥位の画像から体重を推定すること

が可能である。そのため，従来の体重測定で行われてきたような牛を集畜する作業や

正姿勢のまま保持するなどの牛に直接触れるような操作をすることなく自由な姿勢の

乳牛に対して利用可能である。 

 

4.2 本研究の体重計測技術導入の有用性 

 牛の体重測定が広く行われていない理由の一つとして，体重計が高価で大掛かりな

設備で，その導入には多額の費用が掛かるため生産者ごとに備えることができないこ

とが挙げられる。体重計に代わり簡易的に体重を推定する手法である，ヒポメーター

は現時点で国内での販売元が見当たらず入手は困難と考えられる。体重推定尺は，体

重計にくらべてきわめて安価であり，購入後そのまま利用することができるため導入
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しやすいと考えられる。ただし，これらの装置は全て，牛を立位姿勢に保持し，牛の

誘導時や計測時に接触する必要があるため，牛のストレス，計測場所の制限，労力と

危険性の問題が生じる。 

 これら従来からの体重測定法と比較して，本研究で開発された画像を用いた体重計

測技術に利用する画像撮影装置は，家電量販店やホームセンターで入手可能な材料を

工夫することで，安価で作成することがでる。また，撮影画像から牛領域を抽出する

ために利用した画像ソフトウェアや機械学習ソフトウェアはオープンソースであるた

め無料で利用できる。そのため，本技術を生産現場に導入することは容易であると考

えられる。 

 この画像撮影装置は牛のいる場所へ持ち運んで撮影することができるため，畜舎の

みならず放牧地においても牛の撮影が可能であり計測場所の制限が少ない。また，自

由な姿勢の条件下で撮影するため，牛を集畜する作業や正姿勢のまま保持するなどの

牛に直接触れるような操作をすることがなく，牛のストレスの低減が期待できる。こ

れは労力や危険性の問題が少ないことにつながるが，その有用性は，本手法の重要な

成果であるので，その考察については項を分けて以下に説明する。 

 しかしながら，放牧地においては立位以外に伏臥位の姿勢が多く見られるため，こ

の撮影技術を利用して得られる画像には両方の姿勢がある。それゆえ，この撮影装置

を使い体重を推定するには，立位と伏臥位のどちらの画像を利用しても正確に体重を

推定する必要がある。本研究で提案した，画像から計測した体型指標から体重を推定

するモデルは，立位と伏臥位両方の姿勢の画像における体重の推定が可能である。立

位姿勢での体型部位と体重間のアロメトリー関係を示した研究報告があるが，伏臥位

のその関係を示したものはない。伏臥位姿勢においても体型部位と体重の間にアロメ

トリー関係が示されたことは牛の新たな成長研究解析手法を提示している。その関係

を利用し構築した自由姿勢条件での体重推定モデルは，計測時の牛の姿勢の制御を必
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要としない汎用性が高いモデルといえる。 

 また，生育期を通じた体重推定モデルも高い精度で体重を推定できたが，成長段階

毎にモデルを開発することで，より高い精度で体重を推定できる。 

 未経産牛の推定精度は RMSPE を指標として，両姿勢で 0.06–0.07 を示した。坂口

（2006）は，ホルスタイン育成雌牛を対象とした推定誤差率は，ヒポメーターで 5.2–

10.2 %，推定尺で 4.2–5.8 %と報告されている。誤差率の算出方法が若干異なるため一

概には比較できないが，未経産牛における画像からの体重推定の精度は，推定尺より

も若干劣るがヒポメーターと同程度もしくはヒポメーターよりも若干良いと考えられ

る。本研究と Dingwell（2006）がホルスタイン育成雌牛で示した，ヒポメーターと推

定尺の実測値と推定値の関係を比較すると，本研究で提案された画像からの推定手法

は，特に低い体重域でばらつきが少なく，高い精度で推定できていると考えられる。 

 経産牛の推定精度については推定尺，ヒポメーターともにはっきりした情報がない

ため比較できていない。推定尺はその基礎となる胸囲と体重との関係を示した報告の

ほとんどが未経産牛のみを対象としており，経産牛を対象とした場合の推定精度を示

したものは見られない。ヒポメーターはそもそも育成牛用の体重推定器具であり経産

牛には使うことができない。これらに対して本研究の手法は，未経産牛に加えて経産

牛を含め広い体重域の体重推定に利用することができ，汎用性が高い。経産牛の推定

精度は 4.6で示すモデルの高度化により向上すると考えられる。 

 

4.3 労力と危険性の軽減 

 牛の体重測定が広く行われていない理由の一つとして，体重測定の作業に労力がか

かることと，危険性を伴うことが挙げられる。これらの問題に対して，本研究で提案

した体重計測技術は以下に示すような対応ができる。 

 本研究で提案された撮影装置は，持ち運びが可能であり，牛がいる場所に行ってそ
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の場で撮影することが可能である。一般に実施される体重計での計測において，牛を

ロープで引く際に激しく抵抗し作業が困難になる場合がある。また，ロープ誘導に慣

れていない牛を体重計まで誘導する作業は重労働となり，牛の前方からロープを引く

者と牛の後方から追う者の複数の作業員が必要となることがしばしばある。さらに，

無理に体重計の場所までロープ誘導する時，急に走りだしたり，転回したりするなど

の暴走反応を現すことがあり，作業中の負傷事故につながりかねない。本撮影装置を

利用した計測は，集畜やロープ誘導などの労力や牛との接触を必要としないため，上

記のような問題が生じず，省力化と作業中の危険性を軽減につながる。 

 上記のような有用性は，牛舎内での飼養時においても重要であるが，集畜の労力が

多く，接触による危険性が高い放牧地やフリーバーン，フリーストールといった放し

飼い方式ではより高くなる。 

 また，体重計を利用しない推定尺を利用した簡易測定法においても牛を正姿勢で保

持する必要があるため複数の作業員が必要で労力がかかるうえ，胸囲の測定で牛に触

れる時の危険性が生じるため，この手法と比較しても本研究の体重計測技術は有用と

考えられる。 

 

4.4 本研究の体重計測技術導入時の注意点 

 本研究で開発した撮影装置は軽量であるため，牛がいる場所へ持ち運んで撮影する

ことが可能であるが，現地で安定した撮影をするため，以下の点に注意する必要があ

る。本装置は，長尺棒の先端付近にデジタルカメラおよびジンバルを配置しているた

め先端部の方が重くなり，長尺棒が長いほど，そして持つ角度が水平に近いほど支え

るには大きな力を必要とする。支えきれない場合，カメラを地面に落下させてしまう

ことや，牛が驚いて逃げてしまうことがあるので注意が必要である。そのため，本研

究では無理なく支えるために，2.3.1で示したように，長尺棒の長さ，鉛直方向に対す
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る角度を撮影条件に適合させる必要がある。 

 放牧地で撮影のために牛に近づく際は，ゆっくり接近する必要がある。放牧地にお

いて撮影装置を持って牛に近づいたとき，牛は警戒し逃避行動をとることがしばしば

見られる。牛に近づいた時の逃避行動開始までの距離（フライトディスタンス）は近

づく速度により変化することが報告されており，接近速度が速いほどフライトディス

タンスは大きい（Kosako ら 2008）。そのため，接近速度を遅くすることで撮影がしや

すくなると考えられる。仮に逃げられた場合，無理に追いかけるのではなく，牛が落

ち着くまで待つなど，牛の行動を理解して適切に撮影する必要がある。牛の逃避行動

は，本技術の課題の一つであり，後述する 4.5で対応を提案する。 

 体重推定モデルを利用する際には，生育ステージに合ったモデルを選択することが

望ましい。本研究で開発された体重推定モデルは，全体，経産牛，未経産牛，未経産

牛の 250 kg以上と 250 kg未満のモデルである。このうち，未経産牛と経産牛を分ける

ことは容易である。一方，未経産のうち 250 kg以上と 250 kg未満を正確に分けること

はできない。250 kg 付近の牛についてはどちらのモデルを利用しても大きな差は生じ

ないと考えられるが，正確に利用モデルを選択するための方法をここで検討する。両

姿勢で未経産の 250 kg以上，250 kg未満のモデルの変数はいずれも面積のみである。

これより，未経産牛の 250 kg以上のモデルから推定された，250 kg時の体重時の面積

は，立位で1.15 m2，伏臥位で0.86 m2であった。また，未経産牛の250 kg未満のモデル

から推定された，250 kg時の体重時の面積は，立位で 1.24 m2，伏臥位で 0.94 m2であっ

た。このことから両モデルの 250 kg体重時の面積を平均すると，立位で 1.2 m2，伏臥

位で0.9  m2である。この値を利用し，本研究の撮影手法の場合，立位であれば面積1.2 

m2以上と未満で利用するモデルを選択し，伏臥位であれば面積 0.9 m2以上と未満で利

用するモデルを選択すれば良い。もしくは，ホルスタイン登録協会（1995）が示す，

ホルスタイン種雌牛の標準発育値によると，8か月齢の標準体重の平均が 258 kgとさ
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れていることから，生後 8か月でモデルを分けることも一つの方法と考えられる。 

 

4.5 撮影技術の課題と今後の展開 

 4.1 で述べたとおり，第 2 章では体重計測のための画像撮影技術が開発された。し

かし，放牧地で撮影装置を持って牛に近づいたとき，牛は逃避行動を取るため撮影に

時間を要した。これは本研究で開発された撮影技術の課題の一つである。本研究では，

時間の経過とともに牛が撮影装置に慣れ，立位だけでなく伏臥位の画像を取得できた

が，一般的に牛の逃避行動の程度はさまざまであり，想定した通りに撮影できない場

合も考えられる。本研究で開発した撮影装置を牛のいるところに持ち運び，撮影する

ことは十分に可能であるが，放牧地は傾斜地にあることが多く，起伏のある広大な放

牧地で撮影装置を持ちながら移動することはそれ自体が労力の掛かることである。さ

らに撮影対象となる牛に逃げられて撮影に多くの時間を要することになれば，画像を

用いた体重計測の一般化は難しいと考えられる。このため，今後，より簡便な撮影技

術について検討する必要がある。 

 そこで，近年急速に普及し，利用場面が広がっているドローンを利用することが考

えられる。ドローンを活用することができれば牛のいる場所まで行く必要がなくなり，

ある程度高い位置を飛行することで牛に逃避行動をとられることなく撮影できると考

えられる。また，多くの個体を同時に撮影することで群レベルでの撮影が可能となる。 

 ドローンによって上空から撮影された画像は，第 2章で開発された撮影装置と同様

に鉛直方向での撮影が可能であるため，本研究の原理を応用し発展させることが可能

と考えらえる。その際には，第 3章で提案された，立位および伏臥位のモデルに加え

て，本研究で対象としなかった横臥位姿勢についてのモデルを作成することで，さら

に応用の場が広がると考えられる。 

 図 4.1 に牛舎併設の運動場において搾乳牛をドローンで撮影した例を示した。ドロ
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ーン画像を利用した画像の撮影は，高い位置から広範囲を撮影できるため複数頭の牛

を同時に撮影できる。その反面，現時点で体重推定に利用するにはいくつかの課題が

あると考えられる。その一つとして，画像の中央付近から周縁部にかけて位置ズレが

生じ，周縁部に映った牛は斜め上方向から見た画像となり，本研究で必要とされる鉛

直方向の牛画像が得られないため，撮影したそのままの画像では，体重推定には利用

できない可能性がある。そのため，位置ズレを補正し，真上から撮影されたような傾

きのない，正しい大きさと位置に表示されるように正射変換（オルソ画像化）するこ

とを検討するか，もしくは牛の上空を移動しながら動画を撮影し，動画から位置ズレ

の少ない鉛直方向の画像を抽出する手法を検討する必要がある。 

  

図 4.1 ドローンで撮影された牛の画像． 

搾乳牛（約 600–750 kg）を高さ約 40 mから撮影． 
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4.6 モデル精度の向上に向けた今後の展開 

 本研究で提案された画像からの推定手法は，生育ステージを考慮して推定モデルを

利用することが有効であり，全ての生育ステージの体重を一つのモデルで推定しよう

とすると推定精度が低下した。また，未経産牛にくらべて経産牛の推定精度が低かっ

た。これらの問題に対処し，より汎用性が高く推定精度の高い体重推定モデルを開発

するためには，生育ステージを通じた体重と体型指標値との汎用的なアロメトリー関

係と，経産牛における体重推定誤差が生じる機構を解明し，これらの要因を体重推定

モデルに導入する必要がある。 

 まず，全ての生育ステージに利用できる汎用的な体重推定モデルを開発するために

は，アロメトリー関係を考慮したモデルに改良することが考えられる。その理由とし

て，本研究で得られた体重と体型部位の関係は，完全な線形ではなく，非線形関係を

示した。これは体型部位と体重の関係が生育ステージにより異なることを示唆してお

り，この関係によりモデル精度が低下していることが推察された。そのため，変数を

対数化し体型指標と体重とのアロメトリー関係を線形に変換する等の手法を採用する

ことで，生育ステージを考慮する必要のない適切な全体モデルを開発できる可能性が

ある。 

 つぎに，経産牛の推定精度を向上させるためには，分娩後のエネルギーバランスを

考慮したモデルに改良することが考えられる。その理由として，経産牛は分娩後の泌

乳に伴うエネルギーバランスの変化により，体重が大きく変動することが知られてい

る。分娩後は，泌乳開始に伴い，多くのエネルギーを必要とするが，この時期には乾

物摂取量がまだ十分増加していないため負のエネルギーバランス状態（NEB）となる

（Bauman・Currie 1980；Baird 1982）。一般に，NEBは 45日間程度継続するとされ，こ

の時期の体重変化について，Gibb ら（1992）は，泌乳開始からの 8 週の間，1 日あた

り 1.1 kg減少することを報告している。この体重変動に骨格サイズは強く関与しない
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と考えられるため，画像から推定した体型指標のみを説明変数にすると，精度の高い

推定ができないと考えられる。この問題に対処するため，体型指標に加え，分娩後の

日数，泌乳量などのエネルギーバランスの変動を説明する要因，もしくはボディコン

デイションスコア（BCS）を，説明変数に加えた体重推定モデルの開発が有効かもし

れない。一般的な乳牛生産現場において，分娩後の日数，泌乳量は容易に取得できる

データである。BCS については，すでに 2D 画像から測定する手法が報告されており

（Bewleyら 2008；Halachmiら 2008；Azzaroら 2011；Bercovichら 2013），これらの多くは

乳牛の腰角付近と坐骨端ならびに尾尻の窪み付近に着目している。これらの部位は本

研究の第 2章で開発された撮影技術でも容易に確認できる部位であるため，画像から

スコアリングし変数としてモデルに加えることが可能である。 

 

4.7 スマート農業，農業 DXへの貢献 

 スマート農業や農業 DXはデジタル技術を利用して省力的かつ効率的な農業生産を

目指す取り組みで，近年，様々な分野で急速に発展しつつある。体重推定技術の分野

におけるスマート農業，農業DXの一つとして，深度センサーやLiDARなどのセンサ

ーを用いた 3D画像とAIを組み合わせた手法がある。豚ではすでに一部のスマートフ

ォンに搭載されている LiDARを利用し AIにより体重を推定するスマホアプリ（吉角 

2022）が実用化されており，近い将来，牛でも実用化される可能性がある。しかしな

がら，現時点でスマートフォンに搭載されている LiDAR のスキャン可能な撮影距離

は短く，一定の距離以上離れた対象物は検知できない。そのため，豚で開発されたこ

の技術が，たとえ牛に利用できるように改良されたとしても，牛舎内などの限られた

場所での利用か，放牧地に於いては牛のすぐ近くまで赴いて撮影する必要があると考

えられる。 

 一方で，本研究で開発された画像からの牛の体重推定技術は，非接触かつ自由姿勢
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での測定が可能であることから，牛舎，放牧地，フリーバーン等，多様な牛の飼養条

件下で，体重計測できる農業DXの技術として捉えることができる。 

 本体重計測技術を農業 DXの一つとして展開するためには，牛の撮影技術の高度な

DX化とそれによる省力化が考えられる。その一つとして，4.5で提案したドローンを

利用した撮影技術の導入がある。将来ドローンからの画像が体重推定に利用すること

ができるようになれば，労働力の負担軽減と省力化の面だけでなく，放牧管理の情報

取得に役立てることができる。すでに草地生態系におけるドローンの活用場面の例と

して，草地の収量評価，植被率，牧草栄養価，雑草検出が報告されており（川村ら 

2018），放牧家畜の餌となる牧草資源量を知るための基礎的な情報を，ドローンを利

用して収集することができつつある。さらに，ドローンを利用した牛の個体数の計測

技術（Barbedo 2020；Shao 2020）が報告されており，草地を利用する家畜の情報をドロ

ーンで把握する研究も進められつつある。 

 4.5 で提案したドローンを利用した撮影技術と，4.6 で提案した推定モデルの高度化

を組み合わせてさらに発展させて，牛群レベルでの体重推定が高い精度で可能となれ

ば，牧草資源量や家畜個体数などの情報と組み合わせて包括的に放牧管理ができるよ

うになり，より高度で，省力的かつ効率的な家畜生産の実現が期待できる。 

 

4.8 まとめ 

 新たな牛の体重推定技術として，画像を用いた乳牛の自由姿勢条件下での体重計測

技術を開発することを目的として，体重計測のための撮影技術を開発し，自由姿勢お

よび生育ステージを考慮した牛の体重推定モデルを開発した。画像を利用することで，

大掛かりな測定設備を整備する必要がなくなり，牛をハンドリングすることなく体重

を推定することが可能であるため，省力化や測定時における危険性の低減が期待でき

る。牛が示す姿勢の大部分を占める，立位および伏臥位姿勢の画像から，高い精度で
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体重を推定できることを示した本研究の成果は，自由姿勢での体重計測の汎用性と応

用性を考えたときに極めて有用であると考えられる。本研究で開発された画像からの

乳牛の自由姿勢での体重計測技術が，家畜生産発展の一助となると期待する。 
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補 遺 

 

 

補遺 1 Fijiプラグイン Trainable Weka Segmentationによる分節方法と Graph Cutに

よる 2値化方法 

1．ファイルを読み込む  [File] → [Open] 

2．Trainable Weka Segmentation（TWS）を起動する 

[Plugins] → [Segmentation] → [Trainable Weka Segmentation] 

3．牛領域を class 1，非牛領域を class 2にラベルする 

[Freehand line] などで牛領域を選択し [Add to class 1] を押下 

同様に非牛領域を選択し，[Add to class 2] とする 

4．[Train classifier] で学習結果が表示される 

5．[Get probability] でProbability maps（各 classに属する確率を示した画像）が表示される 

6．プラグインGraph Cutを起動する 

[Plugins] → [Segmentation] → [Graph Cut] 

7．牛領域として選択したチャンネル（この場合は 1）を選択して [OK] を押下 

8．[Segment image] を押下することで，2値化された画像が表示される 

9．[wand tool] により牛領域を選択し，ROI マネージャーに追加することで，元画像へ

あてはめ（確認）が可能となる 
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補遺 2 VLCメディアプレーヤによる静止画の取得方法 

1．ファイルを読み込む  [File] → [Open] 

2．ファイルの保存形式，ディレクトリ，プレフィックス，連番付けを設定する（省

略可。設定すれば便利。） 

 [ツール] → [設定] → [ビデオ] 

3．スナップショットを取得したい画像で一時停止する 

4．スナップショットを撮影し，2．で設定した場所への保存する 

[ビデオ] → [スナップショット] 
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補遺 3 Fiji / imageJによる体部位変量の測定方法 

1．ファイルを読み込む  [File] → [Open] 

2．スケールを補正し，測定結果を具体的な長さや面積で表示させる 

[Analyze] → [Set scale]  

3．測定部位を選択する 

①直線部の長さの測定部位の選択（腰角幅，体長） 

[Straight Line] 直線ツールなどで測定したい長さに線を引く 

②湾曲部の長さの測定部位の選択（背骨長） 

[Polygon selections] 湾曲に沿ってポリゴンを複数設定し，測定したい長さに線を引

く 

③面積，外周長の測定部位の選択 

[Freehand selections] で輪郭をおおまかに選択した後，[Selection Brush Tool] で牛の輪

郭に合致するように修正する 

※上記により選択した範囲（ROI: Region of Interest）はROI マネージャーにより保存，

読み込みが可能  [Analyze] → [Tools] → [ROI manager] 

4．選択部位の計測  [Analyze] → [measure] により [Results] が表示される 
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補遺 4 Rによる一般線形モデル探索プログラム 

1．データ入力 

1列目に目的変数 y，2列目に説明変数 x1，3列目に説明変数 x2，4列目に説明変数

x3，5列目に説明変数 x4，6列目に説明変数 x5を入れる。変数の各行の値は対応さ

せる。タブ区切りのText形式として保存（all.txt）。 

2．データの読み込み 

setwd("C:/rdata/200620ritsui") ##ディレクトリの設定，  

  ## " "内はパス名 

(data <- read.table("all.txt", header=T)) ## " "内はファイル名 

attach(data) 

names(data) 

3．データの要約・散布図 

3.a．統計値要約 

(data.n <- nrow(data)) ##全データ数の表示 

summary(data) ##全データ統計要約 

3.b．データプロット 

plot(data, panel=panel.smooth) ##変数間の対散布図の表示 

3.c．変数名の入力 

x1 <- Y ##Y（腰角幅）を x1とする 

x2 <- L ##L（体長）を x2とする 

x3 <- LC ##LC（背骨長）を x3とする 

x4 <- A ##A（面積）を x4とする 

x5 <- P ##P（外周長）を x5とする 

y <- BW ##BW（体重）を yとする 
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4．重回帰分析 

4.a パラメータ，統計値要約 

model <- lm(y~x1*x2*x3*x4*x5) ##モデルへのあてはめ（全変数） 

model <-

lm(y~x1+x2+x3+x4+x5+x1:x2+x1:x3+x1:x4+x1:x5+x2:x3+x2:x4+x2:x5+x3:x4+x3:x5+x4:x5)  

##有意差がない変数をP値が高い順に消去してモデルへのあてはめを繰り返す 

summary(model) ##統計値（代表値，パラメータ， 

 ##p値，決定係数） 

summary(aov(model)) ##統計値（分散分析表，平方和 

  ##S，p値） 

AIC(model) ##赤池の情報基準(AIC) 

4.b 線形回帰-モデル検査図（残差変動，NormalQ-Q，cook距離） 

par(mfrow=c(2,2))  

plot(model, which=1:4)  

par(mfrow=c(1,1))  

4.c モデル予測値と測定値のプロット 

(bv2 <- predict(model))  

par(mfrow=c(1,1))  

plot(y, bv2)  

abline(0,1)  

4.d 予測値と測定値間の精度評価 

#相関性 

cor.test(y, bv2, method="p") ##Peasonの相関係数と有意差検定 

#予測値と測定値の回帰 
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SSr <- summary(lm(bv2 ~ y))  

SSr$coefficients[1]  

SSr$coefficients[2]  

#残差  

resid <- y-bv2 

#2乗平均平方根誤差(RMSE) 

(RMSE <- sqrt(sum(resid^2)/data.n)) 

#平均絶対誤差(MAE) 

(MAE <- sum(abs(resid))/data.n) 

5．データ後処理 

#利用した変数の削除とデータフレームを変数 yで利用できなくする 

rm(list=ls()) 

detach() 
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Weight measurement techniques for dairy cows under free posture 

conditions using mathematical models and image analysis. 

 

Shigefumi Tanaka 

 

 

Summary 

 

Body weight is an important indicator for monitoring the growth and health conditions of cattle. 

It is also frequently used as an indicator for evaluating livestock productivity and breeding selection. 

However, weighing is not widely carried out due to the need for expensive equipment, the labor 

intensive and the risks involved in measurement. Therefore, more effort-saving and simple weight 

estimation techniques need to be developed. If weight measurement technology can be developed 

using images taken of cows, expensive measuring equipment will no longer be necessary. In addition, 

the need for contact with the cow's body will be eliminated, which will lead to reduced labor and 

safety in the measurement process. Thus, this paper aims to develop a new weight estimation 

technique for dairy cows under free-posture conditions using images, and therefore, a photography 

technique for weight measurement was developed (Study I), and a cow weight estimation model 

considering free posture and growth stage was constructed (Study II). 

In Study I, we proposed a technique for photographing cows raised under grazing pasture and 

free barn conditions. By using a simple gimbal and a long stick, the camera could always be pointed 

vertically to the top of the cow. This photographic equipment is lightweight, making it portable to the 

free barn and pasture, and can acquire upper body images in the standing and lying positions. 

Therefore, it is expected to be applied to weight estimation technology from images. In addition, this 
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imaging device is inexpensive and easy to make. Trainable Weka Segmentation (TWS), a machine 

learning technique, was shown to be effective in extracting cow body regions from images in 

grassland. This technique can extract body regions of different cows in free-posture, using a training 

model created from only one individual.  

In Study II, dairy cows at different life stages were photographed from above in both lying and 

standing positions. Several body-shape indices were measured based on the captured images, and 

relationships with body weights were analyzed. From these relationships, we created models to 

estimate body weights using shape indices based on all of the data for each life stage of multiparous 

cows and heifers of more/less than 250 kg. In both standing and lying positions, area measurements 

of the upper portion of the body had the highest correlations with body weight. In the model using 

all of the data, predicted body weights varied most for cattle that were multiparous, and were 

underestimated for low-body weight cattle. In the models of the standing and lying positions created 

for each life stage, body weight was estimated with high accuracy, except in the case of multiparous 

cattle. No bias was shown between body weights in the standing and lying positions. These results 

imply that cow body weights can be estimated using photographs of standing and lying cattle. 

These results indicate that the image-based dairy cow weight measurement technique 

presented in this study has advantages not found in existing weight measurement techniques, such 

as: 1) measurement can be done in the presence of cows in pastures or barns, 2) measurement can 

be done under free posture conditions of standing or lying cows, 3) the labor and risk involved in 

gathering, leading, and holding cows in posture during measurement can be eliminated, and 4) stress 

on cows during measurement is reduced. 

 

 

 


